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Module Introduction

After hearing the lecture and given the topographic and hydrographic 
data for Panama City and Walton County, Florida, the student will 
be able to calculate and visualize erosion and accretion changes for 
the area using the eGIS tools and the Digital Shoreline Analysis
System (DSAS).

ArcGIS Components

• ArcMap
• ArcCatalog
• ArcToolbox

ArcGIS Extensions

• eGIS: Profile Loader
• eGIS: Survey Tools
• Spatial Analyst
• DSAS

Tools and TechnologyOverview

Skills Learned

•Import distance/azimuth profile data and XYZ lidar data
•Create TIN
•Generate Contour Line
•Create Grid Surfaces
•Create Analysis Areas Boundaries
•Calculate Volume Difference between Surveys
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Module Introduction

Working with Digital Data
Lidar data has proven useful for environmental monitoring, contour mapping, 
transportation planning, emergency management, military applications, orthorectification, 
forestry, oil and gas exploration, mining, hydrology, and shoreline management, to name 
a few. 

By using remotely sensed data combined with ground reference points and specialized 
processing software, Lidar enables the measurement of Earth surface elevation for 
natural and manmade features. 

Lidar datasets can be massive – some surveys can be terabytes in size! Many first-time 
lidar users are overwhelmed by the file size and amount of data. The tools in the 
following exercises will help you understand lidar formats and techniques for managing 
the data for analysis.
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Data Visualization & Volume Calculation – Instructor Demonstration

Notes:
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Exercise A: Importing XYZ Data into ArcGIS

A common delivery format for lidar is a common delimited 
XYZ text file.  In ArcGIS ArcMap, you can import 
tabular data and plot the geography in the mapping 
display.  

After completing the exercise, you will 
be able to successfully import and 
plot the geometry of points stored in 
an ASCII text file.

GoalBackground

Objectives

1. Student will be able to 
import ASCII text file

2. Student will be able to plot 
geometry of points
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eGIS: Survey Tools

Lidar data is an integral part for data analysis in coastal 
engineering.  The eGIS: Survey Toolbar was specifically 
designed for coastal engineers to simplify the formatting 
process of lidar datasets. 

You can: 
Generate contiguous TIN or grid surfaces based off of 
existing point files.
Calculate the Volume Difference between surveys.
Cut, extract and view Profile data from surfaces.
View surface in 2D window.

Before these tools can be utilized, lidar data must be 
properly formatted.  
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Exercise A: Importing XYZ Data into ArcGIS

Light Detection And Ranging (Lidar) data are composed of elevation measurements of the 
beach and offshore surfaces and are acquired through aerial topographic and bathymetric 
surveys. The file format used to capture the Lidar mapping data is referred to as “XYZ”
where x is longitude, y is latitude, and z is elevation. Before you can look at the Lidar beach 
mapping data in ArcGIS, you must first acquire a dataset and then load the data set into 
ArcView. 

In most cases, XYZ files are delivered as text files. In order for ArcGIS to recognize the 
contents of the text file, the file must be either comma or tab delimited and contain a header 
row.  A comma-delimited text file should for formatted similar to the text below:

If you receive this error:  

ArcGIS cannot read the 
format of your text file.  Try 
adding a header row in your 
text file.

If your data is in the western 
hemisphere, all X values 
should be negative.

Lidar raw point data can also 
be known as "point cloud“
data.

ArcGIS does not support files 
with an *.xyz extension.  To 
import a file of this type, first 
rename the file type suffix to 
*.txt or *.csv.

Did You Know?

X,Y,Z
-85.7126854,30.1302116,-6.35
-85.7126560,30.1300397,-6.36
-85.7126840,30.1299822,-6.67
-85.7126744,30.1297871,-5.82
-85.7126590,30.1297072,-5.76
-85.7126852,30.1295430,-5.51
-85.7126886,30.1294196,-5.32
-85.7126809,30.1293115,-5.00
-85.7127325,30.1302825,-6.42
-85.7128032,30.1302042,-6.73
-85.7127965,30.1300970,-6.57
-85.7127220,30.1299453,-7.02
-85.7127761,30.1298123,-6.48
-85.7127921,30.1297053,-5.98

Header Row

Comma-delimited 
data attributes.
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Exercise A: Importing XYZ Data into ArcGIS 
Open the Grids.mxd from C:\Training.  Using the “Add Layer” button,          , browse 

to the text file.  The text file must have the extension *.txt or *.csv.

Browse to Panama_City_Pre_50ft.txt in C:\Training\Data\Survey_Data.

Click OK.

Right-click on imported table and select ‘Display XY Data’.

Specify fields to use for X and Y columns using the respective drop-down lists.

Denote X as the X field and Y as the Y field.

A coordinate system can then be selected by clicking on the ‘Edit’ button.

To display the data in a standard coordinate system click on the ‘Select’ button and 
browse to the desired projection.

Select the Geographic Coordinate Systems >  World >  WGS84

After the coordinate system is selected click OK twice. 

ArcMap then builds a point layer for the X,Y points.  

To convert this temporary layer to a shapefile, right-click on the newly created layer 
and select Data from the drop-down menu. From the second drop-down box 
select Export Data. Save the file in the desired directory.

Export the new shape to C:\Training\Data\Survey_Data and name it 
Panama_City_Pre_50ft.shp.  When prompted, add the layer to the table of 
contents.

Did You Know?

Using Symbology properties 
you can color-code elevations.

LatitudeLongitude

SouthingWesting

NorthingEasting

Y FieldsX Fields
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Exercise B: Creating a TIN from Lidar Data

TIN (Triangulated Irregular Networks) datasets can be used 
to display and analyze surfaces. They contain 
irregularly spaced points that have x,y coordinates 
describing their location and a z-value that describes 
the surface at that point. The surface could represent 
elevation, precipitation, or temperature. A series of 
edges join the points to form triangles. The resulting 
triangular mosaic forms a continuous faceted surface, 
where each triangle face has a specific slope and 
aspect.

For vector GISs, TINs can be seen as polygons having 
attributes of slope, aspect and area, with three vertices 
having elevation attributes and three edges with slope 
and direction attributes.

The TIN model is attractive because of its simplicity and 
economy.  TINS are much smaller and easier to 
generate than grids!

Using the eGIS: Survey Tools, create 
a TIN from an existing survey.

GoalBackground

Objectives

1. Student will be able to 
create a TIN using the 
eCoastal interface

2. Student will be able to 
generate contours based off 
of user-defined TIN
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Exercise B: Creating a TIN from Lidar Data
Users must first create a TIN prior to creating contours. To create a TIN, first zoom to the 

extents of the area of interest.

Using the eGIS: Survey Tools toolbar, from the “Surface” menu select “Convert Point 
Layer”.

Select the Point Layer. 

Select Panama_City_Pre_50ft

Select the Z attribute for the elevation field.

Select the projections units of the layer.  (e.g., WGS84 = Decimal Degrees, State Plate = 
Feet, UTM = Meters)

Select Decimal Degrees as the Map Units 

Select the Convert to TIN layer option.

You have the option to create a TIN  on either the current map display (subset of layer) or 
convert all point features in the layer. Convert only the point feature in the map 
view.

Name the TIN layer.

Enter Pre Storm

Click the Convert button.  This creates a new TIN is stored in the C:\Workspace directory.

3

4
5

6
7

8
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Exercise C: Creating Contours from TIN

To create contours from the 3D Analyst menu, select Surface Analysis Contour.  

Select the input surface and set the contour interval.  

Enter ‘1’ for the Contour Interval.  

Click OK to generate the contours.  A new polyline shapefile will be created to reflect 
the contour surface.

It is possible to show a range 
of heights with the generated 
contour layer.

Using a definition query, you 
can write a formula, such as :
CONTOUR < = 5 AND 
CONTOUR > 0
Once applied, only the 
contours for 1 through 5 feet 
will be displayed.

Did You Know?
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Exercise C: Creating Contours from TIN

The contour polylines can be color-coded by depth.  Using the symbology tools, we can apply a graduated color-scheme to 
the contour lines.

Right-click on the name of the Contour layer in the Table of Contents, select Properties.

From the Symbology tab, select Graduated colors under the Quantities option.

Select the Contour field as the Value.

Select a desired color from the Color Ramp.

If you require additional classes, increase the
number using the select box. 

Click OK to submit the changes.

5
6

7
8
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Exercise D: Creating a Grid from Lidar Data

Using the eGIS: Survey Tools, create 
an ESRI Grid from an existing survey.

GoalBackground

Objectives

1. Student will be able to create a Grid 
using the eCoastal interface.

2. Using Survey Tools and options 
available in Spatial Analyst, the 
student will be able to compute 
volume differences between surveys.

Grid surfaces created using the Survey Tools are stored in 
a proprietary ESRI format (ESRI Grid) that supports 
integer and floating point raster grids. Grids are useful for 
representing geographic phenomena that vary 
continuously over space and for performing spatial 
modeling and analysis of flows, trends, and surfaces such 
as hydrology. 

Spatial Analyst provides a rich set of tools to perform cell-
based (raster) analysis. Of the three main types of GIS 
data (raster, vector, and tin), the raster data structure 
provides the most comprehensive modeling environment 
for spatial analysis. Cell-based systems divide the world 
into discrete uniform units called cells, based on a grid 
structure. Every cell represents a certain specified portion 
of the earth, such as a square kilometer, hectare, or 
square meter. Each cell is given a value to correspond to 
the feature or characteristic in which it is located, or 
describes the location, such as an elevation value or soil 
type. 
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Using the Convert Layer tool, select the Point Layer to convert.
Select Panama_City_Pre_50Ft.

Select the Elevation Field.
Select Z

Select the map units of the layer.
Select Decimal Degrees

(e.g., WGS84 = Decimal Degrees, State Plate = Feet, UTM = Meters)

Select “Convert to raster layer”.

You have the option to create a raster grid on either the current map 
display (subset of layer) or convert all point features in the layer.

Select the desired cell size.
Select 50ft.

Name the raster grid layer.
Name the grid, PreStorm_Grid*

Click Convert.  This creates a new grid stored in the C:\Workspace directory. 

Exercise D: Creating Grid Surfaces from Lidar Data

2

3
4

5

6

8

Using the eGIS: Survey Tools toolbar, from the ‘Surface’ menu select ‘Convert Point Layer’.  This application uses the 
Inverse Distance Weighted (IDW) interpolation method to generate the user-defined grid.  Using the form below, the 
user can select the desired cell size and analysis area for the new grid surface.

7

*Be sure to keep the Name of the 
grid LESS THAN 13 characters.
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Exercise E: Creating Grid Surfaces Boundaries

Once the XYZ data has been formatted for use within a GIS, 
surfaces can be interpolated to represent the 
elevations.  Using the Spatial Analyst extensions and 
eGIS Toolbox, surfaces can easily be generated.  

Raster surfaces can easily be created from point data using 
the Spatial Analyst extension.  A GUI interface has 
been provided in eCoastal to assist in the creation of 
raster grid surfaces.

Prior to creating any surfaces, polygon boundaries can be 
created to reflect the extent of the survey.

Using the eGIS: Survey Tools, create 
a bounding polygon on an existing 
survey.

GoalBackground

Objectives

1. Student will be able to generate a new 
polygon shapefile and sketch a boundary 
layer.

2. Student will understand the process of 
creating grid surfaces

3. Student will be able to browse the 
available options of the Convert Point 
Layer tool.
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Exercise E: Creating Grid Surfaces Boundaries

Step 1.  Create Empty Polygon Shapefile.

1. In ArcMap, click on the ArcToolbox icon,       , from the Main Menu 
toolbar.  This will open an ArcToolbox pane to the left.

2. Browse to Data Management Tools Feature Class Create 
Feature Class.  Double-Click on Create Feature Class.

3. Enter in the Output Location

Enter C:\Training\Data\Survey_Data

4. Enter in the Feature Class Name

Enter in “MyBoundary”

5. Select the Geometry Type

Select POLYGON

Boundaries can be created in Inroads, SHOALS Toolbox, or ArcGIS. The following are instructions to 
create a polygon shapefile that represents the survey boundary in ArcGIS.

3

4
5
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Exercise E: Creating Grid Surfaces Boundaries

6. Click OK.

Close the ArcToolbox window by clicking the “x” in the right hand    
corner of the pane.

7. The newly created feature class will be added to ArcMap’s Table of 
Contents. 

Boundaries can be created in Inroads, SHOALS Toolbox, or ArcGIS. The following are instructions to 
create a polygon shapefile that represents the survey boundary in ArcGIS.
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Exercise E: Creating Grid Surfaces Boundaries

Step 2.  Add Geometry to Shapefile

1. Turn on the Editor Toolbar (Tools Editor Toolbar)

2. From the Editor Toolbar, select Editor Start Editing.  

Select the workspace, C:\Training\Data\Survey_Data, of your shapefile from Step 1. 

3. Make sure the C:\Training\Data\Survey_Data\ directory is in the list and click Start Editing.

4. From the Editor Toolbar, select the “Sketch” Tool (red outlined tool above) and click to drop vertices for the 
boundary of your survey.  Check to ensure the Task is set to ‘Create New Feature’.

Sketch a boundary around Panama_City_Pre_50ft.shp

5. When sketch is finished, right-click and select ‘Finish Sketch’. 

6. From the Editor Toolbar, select Editor Stop Editing.  Click Yes to Save Edits.

4
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Exercise E: Creating Grid Surfaces Boundaries

If you would like to crop the newly created raster surface 
by an existing polygon shapefile, the Spatial 
Analyst Options can be adjusted.

1. From the Spatial Analyst menu, select “Options”. 

2. On the General Tab, select “MyBoundary” from 
the Analysis Mask option.

3. Click OK.

4. To perform the crop action, from the Spatial 
Analyst menu, select Raster Calculator

5. Double click on the grid surface, PreStorm_Grid.  
This will add the name of the layer in the evaluation 
box. 

6. Click the Evaluate button.

7. This will generate a temporary, clipped, raster 
surface and add it into the Table of Contents.

Turn off PreStorm_Grid to see the extents of 
the new cropped grid surface.  

Rename the “Calculation” layer 
PreStorm_Clipped

5
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1. Create a new ArcMap Project File.

10. Close ArcMap

9. Save the ArcMap project file as Creating_Grids.mxd in C:\Training\MXD

8. Clip the Post Storm data based on boundaries of Survey and rename the 
Calculation layer, PostStorm_Clipped

7. Create a 50 ft. grid surface from the Post Storm data (Name the grid PostStorm)

6. Create bounding polygon 
(Save in C:\Training\Data\Survey_Data as MyPostStormBoundary.shp)

5. Create 2 foot contours from the Post Storm data

4. Create a Post Storm TIN 
(Save as Post Storm in C:\Training\Data\Survey_Data)

3. Plot the XY Coordinates

2. Import ASCII text file in ArcMap 
(C:\Training\Data\Survey_Data\Panama_City_Post_50ft.txt)
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Exercise  Summary

This five exercises provided you a brief introduction to working with Lidar data in the ArcGIS environment.  Lidar data 
can easily be distributed in an XYZ format, however minor formatting changes are required prior to loading the data into 
ESRI software.  Once the XYZ data are plotted, users can use tools available in ArcGIS’s 3D or Spatial Analyst.  In this 
exercise we were able to create a TIN, contours, and a Grid surface from the Lidar data. 

Exercises A, B, C, D, E 

END OF EXERCISE A, B, C, D, E
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Exercise F: Compare Grid Surfaces
Once two grid surfaces have been created, the user can compute the 

volume differential between the pre- and post- surfaces.  

1. Using the eGIS: Survey Tools toolbar and selecting the “Depth 
Difference” option from the “Surface” menu, the user can define the 
settings for the analysis.

2. Start a new ArcMap project and add in the PreStorm and 
PostStorm grid surfaces stored in C:\Training\Data\Survey_Data.

3. Select the Base survey
Select PreStorm

4. Select the Recent Hydrographic survey
Select PostStorm

5. Select the XY units.
Select Decimal Degrees

6. Select the Z units.
Select Meters

7. Set the Output Settings
Name the Raster “Difference” and set Meters as the Output

8. Click Calculate

3

4

5 6

7

8
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Exercise F: Compare Grid Surfaces

9. The result window will appear.  To save results, 
select File Save As. You do not need to save the 
results for this exercise.

10. A new surface is created representing the volume 
change between the surfaces.

Here, red areas indicate erosion 
and blue areas indicate 
accretion.

9
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Exercise F: Compare Grid Surfaces
1. Once two grid surfaces have been created, the user can 

compute the volume differential between the pre- and 
post-surfaces.  

2. Using the eGIS: Survey Tools toolbar and selecting the 
Profile Tool the user can click, hold and drag to draw a 
profile across a section of the surveys.

Draw a line across the channel

3. Double-click to finish the sketch.

4. The Cross-Section Viewer dialog will appear showing
the relationship between the surveys.  

5. To save or export this graphic, click the respective 
option from the File menu.

6. To calculate the area under the curve, click the
“Calculate Area” button.

2

6
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Exercise F: Compare Grid Surfaces
1. A 3D Viewer utility has been added to allow the user to 

view the surfaces in a quick, 3D environment.

2. To launch this tool, select the ‘3-D Viewer’ option from 
the Surface menu of the Survey Tools.

3. Raster Grid surfaces must already be loaded in the Table 
of Contents.

4. Select a Grid surface from the Raster Layer selection 
box.

5. The surface will be plotted in the 3D Viewer.

6. Use can modify the control values for Light Source, Tilt, 
Exaggeration, and Rotation.

7. If you are satisfied with the display and would like to 
keep the image, click on the Save As.. button and save 
the image as a bitmap. You do not need to save the 
graphic for this exercise.

8. If you prefer to only show a subset of the survey, the 
Spatial Analyst Analysis Extent and the Raster Calculator 
can be used to clip the surface.

2

7

4

5
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9. Zoom into the west jetty of the Pre-Storm Grid surface.

10. From the Spatial Analyst menu, select Options.

11. On the Extent tab, change the Analysis extent to read 
‘Same of Display’.  With this option selected, all future 
calculations will only be computed with the extent defined 
here.

12. Click OK to dismiss the dialog.

13. From the Spatial Analyst menu, select Raster Calculator.

14. Double-Click on the Pre-Storm Grid layer.

15. Click the Evaluate button.  A new surface will be 
generated that is a subset of the main surface.

16. Select the 3-D Viewer tool from the Surface menu of the 
Survey Tools toolbar.

17. Select the ‘Calculation’ layer (newly created Grid 
surface) from the Raster Layer selection box.

18. The survey subset will be displayed.

11

15

14

17
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1. Using the Raster Calculator, create a new Grid surface that is 10 meters greater 
than the PostStorm Grid.  Rename the new surface, “10MetersMore”.

3. Using the Depth Difference Calculator, use the PostStorm Grid as the base 
survey and 10MetersMore as the recent survey.

Why is the newly generated grid one color?

2. Using the eGIS: Survey Tools toolbar and selecting the Profile Tool, drag to 
draw a profile across a section of the surveys.  Is the result was you expected?

Using the post-storm survey located in the C:\Training\Data\Survey_Data directory:

END OF EXERCISE F
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Exercise G: Using the DSAS Extension

The Digital Shoreline Analysis System (DSAS) version 3.0 is a 
software extension to ESRI ArcGIS© v.9+, developed by USGS, that 
enables a user to calculate shoreline rate-of-change statistics from 
multiple historic shoreline positions. A user-friendly interface of simple 
buttons and menus guides the user through the major steps of 
shoreline change analysis. 

DSAS uses a time series of vector shorelines to calculate shoreline 
change.  Shorelines can be digitized from a variety of sources, 
including: DOQQ aerial photgraphs, NOAA T-sheets, USGS 
quadrangle maps, or derived from LIDAR data.  The vector shorelines 
used in the following example were derived from LIDAR data.

For more information on DSAS visit: 
http://pubs.usgs.gov/of/2005/1304/

Thieler, E.R., Himmelstoss, E.A., Zichichi, J.L., and 
Miller, T.L., Digital Shoreline Analysis System (DSAS) 
version 3.0; An ArcGIS© extension for calculating 
shoreline change: U.S. Geological Survey Open-File 
Report 2005-1304. 

E. Robert Thieler
rthieler@usgs.gov
tel: 508-457-2350 
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Exercise G: Using the DSAS Extension

The DSAS extension requires data to exist in a particular format prior to calculating the rate of change.  
The following characteristics of a dataset must exist:

• A user-created baseline must exist. 
• Attribution for DATE and ACCURACY.
• If there are multiple records in the attribute table for a single date, they must be merged

into a single record.
• Multiple shoreline files must be appended into a single feature class.
• DSAS requires the data to be in meter units in a projected coordinate system, such as 

UTM or State Plane.

Our first step will be to create a baseline shoreline. The baseline is created by the user and serves as 
the starting point for generating transects. The DSAS extension generates transects that are cast 
perpendicular to the baseline at a user-specified spacing alongshore. The transect/shoreline 
intersections are used by the program to calculate the rate-of-change statistics.  Once way to create a 
baseline shoreline is to buffer an existing shoreline.

1. In ArcMap, create a new map document.
2. Using the Add Data button, browse to C:\Training\Data\DSAS and add in the 

Walton_County_NOAA shapefile.  
3. Click on the ArcToolbox icon,         , to launch the ArcToolbox window.
4. Click on the Index tab, near the bottom of the ArcToolbox window.
5. Type the keyword ‘buffer’ in the Find input box.
6. Click the Locate button.  The Locate button will bring you directly to the tool in the toolbox.  
7. Double-Click on the Buffer tool to begin the Buffering process.

4

5

6

7
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Exercise G: Using the DSAS Extension

8. Select Walton_County_NOAA for the Input Features option.
9. Browse to C:\Training\Data\DSAS and name the new Output 

Feature class, ShorelineBuffer.shp. 
10. We will be creating a 100 feet buffer around the shoreline.  

Select the Linear Unit option, and enter 100 and select Feet
as the units.

11. Since the feature is a multipart polyline, we would like to 
dissolve the borders of the buffer.  Select ALL for the 
Dissolve Type option.

12. Click OK.
13. Once the Buffer process is complete, close the processing 

window.  The new layer will be added to the Table of 
Contents.  Move ShorelineBuffer below the 
Walton_County_NOAA layer and zoom in.  Notice the 50 feet 
buffer around the shoreline.

8

9

10

11
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1. Using the Add Data button, add in the Pre and Post Hurricane 
Ivan data, located in C:\Training\Data\DSAS.  Notice all 
shoreline fall within the buffer polygon.

2. Our next step will be to alter the buffer polygon and create a 
single polyline from the landward boundary.

3. Create a new POLYLINE feature class using the ArcToolbox.
4. From Data Management Tools Feature Class, double-click on 

Create Feature Class.
5. Create a new POLYLINE Feature Class, BaselineShoreline,

in C:\Training\Data\DSAS.  The new polyline
shapefile will be added to the Table of Contents once
the process is complete.

6. Our next step will be to copy the geometry of the 
polygon features of the ShorelineBuffer and paste them 
into the new polyline feature class.

7. From the Editor menu, select Start Editing.  Be sure
the BaselineShoreline shapefile is in the editing
workspace.

8. Use the Selection tool,        , to select the feature of the
ShorelineBuffer layer.

9. From the Edit menu, select Copy.
10. Select the Edit menu again and select Paste.  This will copy the 

geometry of the buffer and place it as a polyline in the 
ShorelineBuffer shapefile.  
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1. Verify that you are still in an Edit Session for the BaselineShoreline layer.
2. Zoom in to the left boundary of the BaselineShoreline layer.
3. Click the Edit tool.
4. Click to select the line of the BaselineShoreline layer. 
5. Click the Split tool        on the Editor toolbar. 
6. Click where you want to split the line. Click at the bend in the polyline.
7. The line is split into two features.
8. Zoom to the right boundary of the BaselineShoreline layer.
9. Repeat steps 4 – 6.  
10. Now that the polyline is split into multiple parts, we can delete the line segments 

that are no longer needed. 
11. Use the feature selection tool,        , and select the line segment at the bottom of 

the  buffer.
12. Press the Delete key on your keyboard.  This will remove the bottom arc.  The 

polyline should now look like this (bold line).  From the Editor menu select Stop 
Editing. Save your changes.
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1. The Baseline layer must be assigned a projection.  Using the ArcToolbox, define the NAD1983 datum, UTM Zone 
16N to this layer.

2. In the ArcToolbox browse to Data Management Tools Projections and Transformations and double-click on 
Define Projection.

3. Select the BaselineShoreline as the Input Layer.
4. Click the properties button to set the projection.
5. Click the Select button on the Spatial Reference Properties form.
6. Browse to Projected Coordinate Systems UTM NAD 1983 NAD 1983 UTM Zone 16N.prj
7. Click Add.
8. Click OK, OK and Close to remove the processing window.  The layer’s projection has now been defined.
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We now have 3 separate shapefiles representing 3 different years.  DSAS requires 
that all records be appended into a single feature class.  We will use the ArcToolbox
to append the features into one.

1. Create a new polyline feature class named MergedShoreline and save 
in C:\Training\Data\DSAS.

2. DSAS required 2 fields exist in the feature class to store the date and 
accuracy of the shoreline.  Right-click on the MergedShoreline layer and 
open the attribute table.

3. Click on the Options button.
4. Click on Add Field
5. Name the field, DATE_ and set the data type to Text.  Click OK.
6. Add another field, ACCURACY with the data type Short Integer.  Click 

OK and close the attribute table.
7. From the ArcToolbox browse to Data Management Tools General 

and double-click on Append.
8. Add the Pre- and Post- layers are the input layer.
9. Select Merged Shoreline as the Output feature.
10. Click OK to merge all files into one.

7
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Before generating transects, ensure that all baseline segments flow in 
the same direction, so that your transects will cast properly.

To check the flow direction:
1. In the Table of Contents, right-click on the 

BaselineShoreline layer.
2. Select Properties.
3. Click on the Symbology tab.
4. Click on the Line symbol button.
5. Scroll down and find the Arrow at End symbol.  Select this 

symbol and click OK twice.
6. Right-click on the BaselineShoreline layer and select Zoom 

to Layer.  Notice that one arrow exists and it is pointing to 
the right. This will determine which direction we should cast 
our transects.

4
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Now that we have the data formatted for use in the DSAS extension, we are 
ready to cast transects and calculate shoreline change.

1. To begin, in ArcMap, go to Tools -> Customize -> Shoreline 
Toolbar (if it does not turn on automatically)

2. Click on the Set/Edit Default Parameters tool.
3. Select the Baseline and Shoreline Layer as the input feature 

classes.
4. Select the accuracy and date attributes of the Shoreline layer.
5. For this example, we will be using a data accuracy of +/- 2 meters.  

Enter this value into the form.  Click Next.
6. The next screen is used to set the parameters for the transects.

The user can set line spacing, direction of cast, baseline and 
shoreline parameters. Set the following values.

• Default transect spacing = 500 meters
• Sample transect length = 100 meters
• Two-legged transect length = 100 meters
• Direction of cast = Right
• Baseline Parameters = On-shore baselines
• Shoreline Parameters = Farthest intersection

7. Click OK.
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Once the default parameters have been set, transects can be cast. The user 
must specify the location of the geodatabase where the resulting transect 
and intersect files will be stored. The user is also able to select either simple 
or two-legged casts for newly generated transects.

1. From the DSAS toolbar, select the Cast Transects tool.
2. Browse to C:\Training\Data\DSAS\DSAS.mdb for the output 

geodatabase.
3. We will be creating a new transect feature class.  Name this 

dataset MyTransects in the “New transect layer name” input 
box.

4. Set the casting method to Simple cast.
5. Click OK.  The extension will begin to process and cast the 

transects.  Upon completion the new transect layer will be added
to the Table of Contents.

1

2

3

4

Note: If you cast transects and nothing 
happens, make sure the value of the 
ID field in the Baseline attribute table 
has a value other than zero for each 
line segment.



Data Visualization and Volume Calculations using eCoastal 3-38

Coastal Applications Using ArcGIS
Philadelphia District Training

Working with Survey Data

Exercise G: Using the DSAS Extension

Once the transects are cast, using the symbology options in 
ArcMap, the user can view the rate of change.

1. Right-click on the MyTransects layer and select 
Properties.

2. Click on the Symbology tab.
3. Under the Quantities category, select Graduated 

colors.  This will allow us to color the transects based 
on an attribute value.

4. Select EPR as the Value field.
5. Select the Green-Yellow-Red ramp.
6. On our map we would like Red to represent erosion and 

green to represent accretion, so we will flip the colors.
7. Right-click anywhere in the symbology preview box and 

select Flip Symbols from the context menu.
8. Notice the color ramp is flipped. Click OK to close the 

layer properties.
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We used the end point rate (epr) to symbolize the transect features on 
the mapping display.  EPR is calculated by dividing the distance of 
shoreline movement by the time elapsed between the earliest and latest 
measurements (i.e., the oldest and the most recent shoreline). 

The major advantage of the epr is its ease of computation and minimal 
requirement for shoreline data (two shorelines). The major disadvantage 
is that in cases where more than two shorelines are available, the 
information about shoreline behavior provided by additional shorelines is 
neglected. Thus, changes in sign or magnitude of the shoreline 
movement trend, or cyclicity of behavior may be missed.

In the mapping display, zoom into green and red colored transects.  
Verify distances between the Pre- and Post- storm shorelines are greater 
with the red transects.

For details on transect 
attribution, visit 
http://pubs.usgs.gov/of/2005/1304
/images/pdf/DSASv3_guide.pdf
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Volume Calculation & Data Visualization Using eCoastal Tools

This module provided instructions and insight on the steps necessary to create surfaces from lidar data and use of the 
Digital Shoreline Analysis system to calculate shoreline change. You should now be able to calculate and visualize 
erosion and accretion changes for the area, by viewing and analyzing the generated surfaces or generating shoreline 
change transects with the DSAS extension. The eGIS: Survey Tools were created to assist the user by providing a GUI 
interface to common practices of the coastal engineer.

Module Summary


